Crude Tower Simulation – HYSYS v10

Steps to set up a simulation in HYSYS v10 to model a crude tower system consisting of:

- Crude Oil Preheat Train
- Atmospheric Crude Tower
- Vacuum Crude Tower
- Debutanizer to stabilize the overhead naphtha stream from the Atmospheric Crude Tower

The feedstock to the crude system will be an equal mix of Light, Medium, & Heavy Crude oils.

When the simulation is set up the overall PFD should look like the following figure.

The steps to set up this simulation in previous versions of HYSYS (back to v8.6) are essentially the same, though some of the screen options may be slightly different.

Create new simulation file

When running under Windows 10 you can start the program from Start, the all programs list, Aspen HYSYS, Aspen HYSYS V10. When the program opens choose the New button.
Define the Components & the Property Models

Specify components, fluid property packages, & crude oil assays

The first step is to add a set of pure chemical species to represent the light components of the crude oils. With Component Lists highlighted click on the Add button. From the list of pure components pick water, methane, ethane, propane, i-butane, n-butane, i-pentane, & n-pentane. Note that you can pick a single component at a time or highlight components & add at the same time. You can also reorder the components in the list & drag to a new position.
The next step is to pick a fluid property package. From the Fluid Packages screen click the Add button. Choose the Peng-Robinson option and make sure it is associated with Component List – 1.
We now want to add assay data for the three crude oils: Light Crude, Medium Crude, & Heavy Crude. The data to be added is shown in the following tables.

<table>
<thead>
<tr>
<th>IBP</th>
<th>EP</th>
<th>@ IBP</th>
<th>@ Mid</th>
<th>Density lb/ft³</th>
<th>Sulfur wt%</th>
<th>Light Ends Analysis [wt%]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whole Crude</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ethane 0.000</td>
</tr>
<tr>
<td>31</td>
<td>160</td>
<td>0</td>
<td>2.5</td>
<td>42.75</td>
<td>0.019</td>
<td>Propane 0.146</td>
</tr>
<tr>
<td>160</td>
<td>236</td>
<td>5</td>
<td>7.5</td>
<td>45.40</td>
<td>0.031</td>
<td>i-Butane 0.127</td>
</tr>
<tr>
<td>236</td>
<td>347</td>
<td>10</td>
<td>15</td>
<td>48.33</td>
<td>0.060</td>
<td>n-Butane 0.702</td>
</tr>
<tr>
<td>347</td>
<td>446</td>
<td>20</td>
<td>25</td>
<td>50.46</td>
<td>0.379</td>
<td>i-Pentane 0.654</td>
</tr>
<tr>
<td>446</td>
<td>545</td>
<td>30</td>
<td>35</td>
<td>52.38</td>
<td>1.064</td>
<td>n-Pentane 1.297</td>
</tr>
<tr>
<td>545</td>
<td>649</td>
<td>40</td>
<td>45</td>
<td>54.18</td>
<td>1.698</td>
<td></td>
</tr>
<tr>
<td>649</td>
<td>758</td>
<td>50</td>
<td>55</td>
<td>56.04</td>
<td>2.159</td>
<td></td>
</tr>
<tr>
<td>758</td>
<td>876</td>
<td>60</td>
<td>65</td>
<td>57.92</td>
<td>2.554</td>
<td></td>
</tr>
<tr>
<td>876</td>
<td>1015</td>
<td>70</td>
<td>75</td>
<td>60.05</td>
<td>3.041</td>
<td></td>
</tr>
<tr>
<td>1015</td>
<td>1205</td>
<td>80</td>
<td>85</td>
<td>62.84</td>
<td>3.838</td>
<td></td>
</tr>
<tr>
<td>1205</td>
<td>1350</td>
<td>90</td>
<td>92.5</td>
<td>64.92</td>
<td>4.503</td>
<td></td>
</tr>
<tr>
<td>1350</td>
<td>FBP</td>
<td>95</td>
<td>97.5</td>
<td>70.64</td>
<td>6.382</td>
<td></td>
</tr>
</tbody>
</table>

Note: HYSYS uses a water density to convert to specific gravity of 62.3024 lb/ft³ = 8.32862 lb/gal = 997.989 kg/m³.
### Table 2. Assay Data for Medium Crude

<table>
<thead>
<tr>
<th>IBP</th>
<th>EP</th>
<th>@ IBP</th>
<th>@ Mid</th>
<th>Cumulative Yield [wt%]</th>
<th>Density [lb/ft³]</th>
<th>Sulfur [wt%]</th>
<th>Light Ends Analysis [wt%]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whole Crude</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>55.00</td>
<td>2.83</td>
<td>Ethane 0.000</td>
</tr>
<tr>
<td>88</td>
<td>180</td>
<td>0</td>
<td>2.5</td>
<td></td>
<td>43.47</td>
<td>0.022</td>
<td>Propane 0.030</td>
</tr>
<tr>
<td>180</td>
<td>267</td>
<td>5</td>
<td>7.5</td>
<td></td>
<td>47.14</td>
<td>0.062</td>
<td>i-Butane 0.089</td>
</tr>
<tr>
<td>267</td>
<td>395</td>
<td>10</td>
<td>15</td>
<td></td>
<td>49.42</td>
<td>0.297</td>
<td>n-Butane 0.216</td>
</tr>
<tr>
<td>395</td>
<td>504</td>
<td>20</td>
<td>25</td>
<td></td>
<td>51.83</td>
<td>1.010</td>
<td>i-Pentane 0.403</td>
</tr>
<tr>
<td>504</td>
<td>611</td>
<td>30</td>
<td>35</td>
<td></td>
<td>54.08</td>
<td>2.084</td>
<td>n-Pentane 0.876</td>
</tr>
<tr>
<td>611</td>
<td>721</td>
<td>40</td>
<td>45</td>
<td>55.90</td>
<td>2.777</td>
<td></td>
<td></td>
</tr>
<tr>
<td>721</td>
<td>840</td>
<td>50</td>
<td>55</td>
<td>57.73</td>
<td>3.284</td>
<td></td>
<td></td>
</tr>
<tr>
<td>840</td>
<td>974</td>
<td>60</td>
<td>65</td>
<td>59.77</td>
<td>3.857</td>
<td></td>
<td></td>
</tr>
<tr>
<td>974</td>
<td>1131</td>
<td>70</td>
<td>75</td>
<td>62.30</td>
<td>4.706</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1131</td>
<td>1328</td>
<td>80</td>
<td>85</td>
<td>65.74</td>
<td>5.967</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1328</td>
<td>1461</td>
<td>90</td>
<td>92.5</td>
<td>68.08</td>
<td>6.865</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1461</td>
<td>FBP</td>
<td>95</td>
<td>97.5</td>
<td>73.28</td>
<td>8.859</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Table 3. Assay Data for Heavy Crude

<table>
<thead>
<tr>
<th>IBP</th>
<th>EP</th>
<th>@ IBP</th>
<th>@ Mid</th>
<th>Cumulative Yield [wt%]</th>
<th>Density [lb/ft³]</th>
<th>Sulfur [wt%]</th>
<th>Light Ends Analysis [wt%]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whole Crude</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>55.20</td>
<td>2.8</td>
<td>Ethane 0.039</td>
</tr>
<tr>
<td>27</td>
<td>154</td>
<td>0</td>
<td>2.5</td>
<td></td>
<td>42.92</td>
<td>0.005</td>
<td>Propane 0.284</td>
</tr>
<tr>
<td>154</td>
<td>255</td>
<td>5</td>
<td>7.5</td>
<td></td>
<td>45.75</td>
<td>0.041</td>
<td>i-Butane 0.216</td>
</tr>
<tr>
<td>255</td>
<td>400</td>
<td>10</td>
<td>15</td>
<td></td>
<td>49.44</td>
<td>0.341</td>
<td>n-Butane 0.637</td>
</tr>
<tr>
<td>400</td>
<td>523</td>
<td>20</td>
<td>25</td>
<td></td>
<td>52.23</td>
<td>1.076</td>
<td>i-Pentane 0.696</td>
</tr>
<tr>
<td>523</td>
<td>645</td>
<td>30</td>
<td>35</td>
<td></td>
<td>54.49</td>
<td>1.898</td>
<td>n-Pentane 1.245</td>
</tr>
<tr>
<td>645</td>
<td>770</td>
<td>40</td>
<td>45</td>
<td>56.62</td>
<td>2.557</td>
<td></td>
<td></td>
</tr>
<tr>
<td>770</td>
<td>902</td>
<td>50</td>
<td>55</td>
<td>58.77</td>
<td>3.185</td>
<td></td>
<td></td>
</tr>
<tr>
<td>902</td>
<td>1044</td>
<td>60</td>
<td>65</td>
<td>61.09</td>
<td>3.916</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1044</td>
<td>1198</td>
<td>70</td>
<td>75</td>
<td>63.61</td>
<td>4.826</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1198</td>
<td>1381</td>
<td>80</td>
<td>85</td>
<td>66.63</td>
<td>5.990</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1381</td>
<td>1500</td>
<td>90</td>
<td>92.5</td>
<td>68.71</td>
<td>6.775</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1500</td>
<td>FBP</td>
<td>95</td>
<td>97.5</td>
<td>73.10</td>
<td>8.432</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The following steps show how to enter the data for Light Crude. Similar steps should be used for the other crude oils. The steps will be shown using the *Oil Manager*.

- Click on the *Oil Manager* button in the *Home* tab. You will have the options to install individual crude oil assays & then create a blend of the assays.

- Click on the *Input Assay* button & then the *Add* button. In the *Assay Definition* section we want to use *Bulk Properties*, specify a TBP *Assay Data Type*, input compositions for the *Light Ends*, and input an independent *Density Curve*. Ensure the *Assay Basis* is Mass. When all of these are specified the Input Data should look like below.

2 Though the Assay Manager is more powerful it requires a special license which may not be available to you at your location.
Let’s input the TBP curve on a wt% basis for Light Crude. Click on the Edit Assay... button. Since we will be entering 12 data points enter 11 for the Num of Points to Add & click the Add Data Points button (since 1 is already showing). Now the table of Cumulative wt% Yield values (scaled 0 to 100) vs. temperatures (in °F) can be entered. Click OK.
• Now we’ll add in the composition of the light ends. Make the **Light Ends** option active & the form will change to allow you to enter the compositions (based on the component list previously specified). Make sure you change the **Light Ends Basis** to **Mass%**.

![Input Data](image1.jpg)

• Now we’ll add in the density data. Make the **Density** option active & the form will change to show you the density vs. yield data entered. Click on the **Edit Assay…** button. Since we will be entering 12 data points enter **11** for the **Num of Points to Add** & click the **Add Data Points** button (since 1 is already showing). Now the table of Cumulative wt% Yield values at the middle of the cut (scaled 0 to 100) vs. standard liquid density values (in lb/ft³) can be entered. Click **OK**. Note that even though the standard liquid density might be in the crude oil assay in other forms (such as specific gravity of API gravity) HYSYS will request the information in a specific form & it cannot be changed on this form.

![Assay Input Table](image2.jpg)
Let’s finish adding in the data needed to characterize the assay and allow HYSYS to create pseudo components. Make the **Bulk Props** option active & the form will change to allow you to enter the data. The only information we have to add is the standard liquid density for the whole crude. Enter this value in the **Standard Density** field. Note that other units can be used on this form. Further note that whatever units are used for the data entry HYSYS will convert the value to the units the form is expecting (in this case API gravity).

Even though we can now characterize the pseudo components for the flash calculations we still need to add the sulfur distribution so that this can be tracked. First we’ll have to define a User Property that represents the sulfur content. Click on **User Properties** either from the tree structure in the left-hand column or the appropriate button under the **Home** tab. When the User Properties form comes up press the **Add...** button.
On the UserProp-1 form choose the Mass Fraction option & leave the F1 through F5 mixing parameters to the default 1 & 0 values. (These will give an untranslated mass fraction mixing of the pure & pseudo component values.) Set the values for the pure components as zeroes.

Let’s make the label for this property more meaningful. Return to the User Properties tab and single click the UserProp-1 label. Now type in “Sulfur Vals”.
Now we can add the sulfur distribution for the assay. Click on Assay-1 in the tree structure in the left-hand column & choose the User Curves tab. Highlight Sulfur Vals in the Available Properties column & press Add-->. Under the User Curve Data area retain the Independent setting for the Table Type, enter the whole crude value for the Bulk Value, and set the lower and upper limits to 0 and 100 (scroll down the list to find these properties). Press the Edit... button at the bottom of the form to enter the assay values. Press OK.

- One more thing to clean up for the assay, changing its name. Click on Input Assay in the tree structure of the left-hand column. In the Input Assay form single click Assay-1 & type Light Crude.
Repeat the steps for the Medium & Heavy Crudes.

*Do characterization calculations, specify crude oil blend, & install into flowsheet*

After entering the assay we have to tell HYSYS to perform the characterization calculations. Select each crude oil in the tree structure of the left-hand column & click on the *Calculate* button if there is a warning that the assay has not been calculated. When properly calculated there should be a message in green.

Now we’ll create a blend of the three crudes and use that as our feedstock in the simulation. Select *Output Blend* in the tree structure of the left-hand column. On the *Output Blend* tab select the *Add* button. On the *Blend-1* tab select the crudes & press *Add*-->*. Accept the *Liquid Vol* option for the *Flow Units*. Enter three equal flow units under *Flow Rate*, such as 33 kbdp (thousands of barrels per day).
If all of the crude oils have been characterized previous to this then you should receive a Blend Was Calculated message in green.

One more cleanup step, changing the name of the blend. Select Output Blend in the tree structure of the left-hand column. In the tabbed form select Blend-1 and change to Mixed Oil.

The next step is to install the blend into the flowsheet. From this tabbed form select Oil Manager and then select Install Oil from the next form. Now we get a form that we can install one or more of the oils. We're only interested in installing the blend, Mixed Oil. In the Stream Name column enter Crude Oil for Mixed Oil. Click Install.
As a final step let's make sure everything is calculated & the pseudo components are installed into the component list. Select Oil Manager in the tree structure in the left-hand column. At the bottom of the form click Calculate All. Now when you look at the Component List you should see a series of pseudo components after the pure components chosen earlier.

Set up & Solve the Flowsheet

Units Used in Simulation

Before actually setting up the simulation we should determine what set of units are being used. The preference for this example is to use U.S. Customary units (temperature in °F, liquid flow in bbl/day, mass flow in lb/hr, etc.). There is a default unit set, Refining, that is almost everything that we will want.

Under the Home tab there is a section for Units that show the current set being used & a button to change options within a unit set. For this problem the default is a set called NewUser1 (for new files the starting set is dependent on what was previously used on the particular computer being used). To ensure the actual set being used let's create a new one which we will call Refining-US. Click on the Unit Sets button to bring up the form to examine the available unit sets & change (if desired).

In the lower section let's start with the refining unit set. Select refining & press Copy. A new unit set will be created (here called NewUser2). Double click on this name & enter Refining-US.
In the upper section we can set the units used for various properties in the simulation. We can see that most units used are very reasonable. For example, temperature is in °F, standard volumetric flow is in bbl/day, & pressure is in psia.
The pressure units would normally be OK, but we’d like to see gauge pressure in this problem instead (especially since all of the operating conditions will be given in this way). We can change the units by clicking on the pressure’s dropdown list & choosing psig instead. Click OK when done to close this form.

**Crude Oil Feed & Preheat**

When you activate the Simulation you’ll see a single steam called Crude Oil. We want to process this stream through two heat exchangers (to model the preheat before & after the Desalter) and a Mixer to set an expected amount of water in the Crude Oil coming from the Desalter.

One way to start the set up is to define the unit & stream attachments before worrying about defining stream compositions & conditions. This can be done by dragging the appropriate units from the Model Palette to the flowsheet (2 Heaters & one Mixer) and then using the Design Connection window to create & attach the streams. For example, after double-clicking on the Heater representing Preheat-1 the Design Connection window should look like the following. Note the following:

- The Crude Oil stream was associated with the Inlet by pulling down the list & choosing this existing stream. It exists because it was created in the Properties definition step when you clicked the Install Oil button.
- The steam names Q-Preheat-1 & Warm Crude 1 can be typed into the Energy & Outlet stream areas. Since these streams do not yet exist they will be created & shown on the PFD.
The name of the *Heater* can be changed by double-clicking on the *Name* field & replacing with what you want (here *Preheat-1*).

The following are the conditions to be set on the operations.
- Crude Oil Feed: 100°F, 300 psig, 101,000 bpd
- Preheat-1 outlet: 260°F, 294 psig
- Desalter outlet: 260°F, 294 psig, 500 bpd of water
- Preheat-2 outlet: 450°F, 260 psig

The conditions on the streams can either be set directly on the stream through its forms, indirectly using the unit forms, or a combination of the two. (There are actually other options using *Adjust* operations & spreadsheets but these will be discussed later.)

Double-click on the *Crude Oil* stream to open up the entry forms for this stream. Note that the flow rate comes from *Oil Manager*, but we're going to overwrite this. Note that once you enter the pressure & temperature the necessary conditions to define the phase condition for *Crude Oil* are complete & the flash calculations are performed; this is designated by the stream taking on a new color in the flowsheet & the message *OK* is shown at the bottom the stream's form..
Double-click on the unit for Preheater-1 & select the Conditions option under the Worksheet tab. Let’s define the pressure & temperature in this window. Note these are sufficient
conditions to flash the outlet stream & determine the required heat.

Operating conditions (such as pressure & temperature) & compositions can be set either from the stream forms or the unit forms; there is greater flexibility in setting compositions of a stream from the stream forms. Here we’ll set the entrained water by opening up the input form for Desalter Water. On the Worksheet tab select Composition. Click on the Edit… button, enter 1 for the fraction of H2O, click the Normalize button, and then OK. Next we will set the pressure of the entrained water (same as the outlet from the Desalter) & the flowrate. Note that we will not set the temperature at this time.
Now let’s set the conditions for the outlet of the Desalter. Double click on the *Mixer* and click on the *Worksheet* tab. Note that the pressure of the outlet stream has been determined (set as the lowest pressure of all streams being mixed) & the standard liquid flowrate has been determined (since this is just additive of the two streams into the Mixer). Now, let’s specify the temperature of the outlet of the Desalter; note that the temperature of the water stream has been back-calculated to enforce the adiabatic nature of the *Mixer* operation.
Before specifying outlet temperature:

After specifying outlet temperature:

Specifying outlet conditions on the second preheater completes the flowsheet calculations for this part of the simulation.

**Atmospheric Distillation Column**

The next step is to set up the Atmospheric Distillation Column. Table 4 contains the conditions & configuration for this column.

The fired heater on the feed is separate from the column environment & will be created first. Create a new Heater on the flowsheet & call it *Atm Heater*. Change the icon to look like a heater instead of a shell & tube heat exchanger. Enter the following connections & set the following outlet conditions to match the approximate atmospheric column conditions in Table 4.
This portion of the PFD should look like the figure on the right.

Setting up a distillation column is a multi-step process in HYSYS. First, create a *Refluxed Absorber Column* on the flowsheet then start to fill in the information. (The icon for this unit can be found under the *All* tab of the model palette or specifically under the *Separator* tab.)
**Table 4. Definitions for Atmospheric Distillation Column**

<table>
<thead>
<tr>
<th>Type</th>
<th>Operating Parameter</th>
</tr>
</thead>
</table>
| **Trays & Efficiencies** | 50 trays. Numbering from top: Trays 1 to 6: 80%  
Trays 7 to 10: 50%  
Trays 11 to 16: 70%  
Trays 17 to 30: 50%  
Trays 31 to 39: 30%  
Tray 40: 100%  
Trays 41 to 50: 30% |
| **Condenser Type**     | Total Condenser; 130°F (approximate)  
Distillate product 410°F D86 T95; 30,200 bpd (approximate)                                                                                                                   |
| **Reboiler Type**      | None, Direct Fired Heater                                                                                                                                                                                                 |
| **Pressures**          | Condenser: 4 psig  
Top Tray: 12 psig  
Bottom Tray: 22 psig                                                                                                                                                    |
| **Temperatures**       | Top Tray #1 250°F (estimate)  
Bottom Tray #50 650°F (estimate)                                                                                                                                              |
| **Feed Locations**     | Crude oil to Tray #40  
Stripping Steam at bottom (Tray #50) – 20,000 lb/hr @ 500°F, 150 psig                                                                                                 |
| **Feed Heater**        | Outlet @ 25 psig & 635°F  
Desire is 2,500 bpd overflash (liquid rate from tray above feed, Tray #39)                                                                                             |
| **Side Stripper**      | Kerosene Stripper  
10 trays @ 30% efficiency  
Kerosene draw from Tray #10, vapor returned to Tray #6  
Stripping steam @ bottom (Tray #10) – 2500 lb/hr @ 500°F & 150 psig  
Kerosene product 525°F D86 T95; 8800 bpd product (approximate)                                                                                                   |
|                       | Diesel Stripper  
10 trays @ 30% efficiency  
Diesel draw from Tray #20, vapor returned to Tray #16  
Stripping steam @ bottom (Tray #10) – 2500 lb/hr @ 500°F & 150 psig  
Diesel product 645°F D86 T95; 10,240 bpd product (approximate)                                                                                                   |
|                       | AGO Stripper  
10 trays @ 30% efficiency  
AGO draw from Tray #30, vapor returned to Tray #26  
Stripping steam @ bottom (Tray #10) – 2500 lb/hr @ 500°F & 150 psig  
AGO product 750°F D86 T95; 3835 bpd product (approximate)                                                                                                       |
| **Pumparound**         | Kerosene Pumparound  
Draw from Tray #10, returned to Tray #7  
25,000 bpd flow, 200°F return temperature                                                                                                                                    |
|                       | Diesel Pumparound  
Draw from Tray #20, returned to Tray #17  
15,000 bpd flow, 250°F return temperature                                                                                                                                 |
|                       | AGO Pumparound  
Draw from Tray #30, returned to Tray #27  
10,000 bpd flow, 350°F return temperature                                                                                                                                 |
When you double click on the column for the first time a wizard starts and will guide you through entering information. If you don’t fill it all in, don’t worry – you can always specify the information from the forms & column sub-flowsheet.

The first step in the wizard is to set up the basic information for the main feeds & products (but not the side products which will be processed through side strippers). Fill in the information as shown below. Make sure you check the box for Water Draw. When done press Next>.

The next step is to set up the basic pressure profile in the column. Fill in values & press Next>.
Press Next>. On the third screen we will set an estimate for the condenser temperature. Though the other temperatures are not required it’s usually good practice to enter values. For an atmospheric crude tower reasonable starting points are 250°F & 650°F for the top & bottom stages, respectively.

Press Next>. On the fourth screen we’ll set an estimate for the distillate rate.

Press the Side Ops> button to start setting up the side strippers & pumparounds. We’ll skip this first side operation screen since none of the side strippers are reboiled (they use stripping steam instead). Press Next>. 
Now we can start adding the basic information for the three side strippers. To start entering the configuration information for each side stripper press the *Add Side Stripper* button; when done press the *Install* button. When done with the three side strippers press the *Next>* button.

We do not have any side rectifiers. Press the *Next>* button.

Now we can start adding the basic information for the three pumparounds. To start entering the configuration information for each pumparound press the *Add Pump-Around* button; when done press the *Install* button. When done with the three pumparounds press the *Next>* button.

We do not have any vapor bypasses. Press the *Next>* button.
Now we can enter the side product flows through the side strippers. Enter the estimates for the flowrates out the bottom of the strippers & then press Next>.

Now we can set the specs on the pumparounds. Enter the flowrate values & the values associated with the heat exchanger duties. Note that all of the duty/temperature specs are Return T type. When done press Next>.

Now we can set the pressures in the side strippers. Use the default values with no changes. Press Next>.

Now we can set the pressure drops across the pumparounds. Use the default values of zero. Press Done.

Distillation columns are different from the rest of the HYSYS operations in that they do not automatically run the first time they are created; rather, you must press the Run button when everything has been set up properly. However, we still have a couple more changes to make so let’s not do this yet.

First, let’s specify the stage efficiencies to model the stages as real trays. Under the Parameters tab select Efficiencies. Make sure that Overall & User Specified items are highlighted. Now let’s start applying the efficiencies in Table 4. Note that stages associated
with the side strippers are listed in this table as if part of the main column (in a way they are, but that’s a subject for a different discussion).

The next requirement is to specify the steam streams. This can be done using the **Worksheet** tab. Select **Conditions** and specify the temperature, pressure, & mass flowrate values. Select **Compositions**; now the compositions can be set as 100% H2O (entering a value of 1 will bring up the **Input Composition** form; press the **Normalize** button & then **OK**). Note that once these values are entered for the steam streams those flash calculations can be completed; the associated calculations for the product streams cannot be done until the tower calculations are completed.
Even though we don’t have all of the operating specs added we can do an initial run of the simulation by pressing Run. You should get a converged solution within 10 iterations.

How can the distillation column equations be solved without putting the composition specs? This is because the “estimated” flowrates entered during the setup are used as the actual specifications. We can see this by checking the Spec Summary setting under the Design tab. Notice that all of these flowrate specs have checks in the Active column; this means that these values are the specifications to which the solution is driven.
Let’s now add the composition specs but not make them active. Select *Specs* under the *Design* tab. In the *Column Specifications* area we can add, remove, or change any of the specs that will show up in the Summary. Let’s first add the ASTM D86 95 vol% temperature spec for the Naphtha stream. Click *Add…* In the list that comes up choose *Column Cut Point* (do not choose *End Point Based Column Cut Pint Spec* near the bottom of the list) & click *Add Spec(s)*… Call the spec Naphtha D86 T95, associate the spec with the liquid phase off of the Condenser, set the % as 95, and set the Spec Value as 410°F. (Keep the default *API 1974* conversion method.) You can now close the form.
Once we close the input form we can see information about the specification details. The value is supposed to be 410°F but because the spec is not active the value is 419.4°F. Close, but not close enough. In the actual operation of the tower we would adjust the distillate draw rate to make this spec. In HYSYS we make the Distillate Rate spec inactive & make the Naphtha D86 T95 spec active. The easiest way to do this is from the Specs Summary form. Changing the check boxes will cause the tower to rerun & quickly converge. Now when we check the individual specs by selecting Specs under the Design tab we see that the Distillate Rate value is 29,320 bpd, not the 30,200 bpd estimate.
We can create similar design specs for the Kerosene, Diesel, & AGO D86 T95 values. Each time we make the T95 spec active we will make the corresponding production rate inactive. Note that when we make these specifications the stream associated with the spec will be the liquid from the bottom of the appropriate side stripper. Finally, when you compare the actual production rates to the initial estimates you may find that each change in a T95 spec may change other production rates, not just the one associated with that spec. For example, adding all of these T95 specs will change the naphtha rate to 29,260 bpd.
Debutanizer Column

Next, let’s do the simpler of the two remaining columns, the Debutanizer Column (i.e., the Naphtha Stabilizer). We will want to operate the Debutanizer at a higher pressure than the Atmospheric Distillation Column, so we will need a pump for the Unstabilized Naptha. We will also preheat the feed entering the column. Table 5 shows the operating conditions for the column & the feed’s pump & preheater.
Table 5. Definitions for Debutanizer Column

<table>
<thead>
<tr>
<th>Type</th>
<th>Operating Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feed Prep</td>
<td>Increase pressure to 250 psig; use default adiabatic efficiency for pump (75%) Preheat to 250°F; assume negligible pressure drop through exchanger</td>
</tr>
<tr>
<td>Trays &amp; Efficiencies</td>
<td>45 trays. Number from top. All trays 80% efficiency</td>
</tr>
<tr>
<td>Condenser Type</td>
<td>Total condenser</td>
</tr>
<tr>
<td></td>
<td>1.5 reflux ratio</td>
</tr>
<tr>
<td>Reboiler Type</td>
<td>Kettle reboiler</td>
</tr>
<tr>
<td>Pressures</td>
<td>Condenser: 150 psig Top Tray: 150 psig Bottom Tray: 160 psig Reboiler: 160 psig</td>
</tr>
<tr>
<td>Temperature</td>
<td>No other estimates needed</td>
</tr>
<tr>
<td>Feed Locations</td>
<td>Unstabilized Naphtha to Tray #22</td>
</tr>
<tr>
<td>Products</td>
<td>Overhead LPGs, 5,500 bpd Stabilized naphtha from bottom</td>
</tr>
</tbody>
</table>

Place a *Pump* on the flowsheet & define the following connections. Retain the default adiabatic efficiency (75%). Set the outlet pressure as 250 psig in the *Worksheet* tab.
Place a *Heater* on the flowsheet & define the following connections. Set the pressure drop in the *Parameters* section (*Delta P*). Since the outlet pressure is calculated from the pressure drop it does not have to be set on the *Worksheet* tab. However, we still need to set the outlet temperature & this can be done on the *Worksheet* tab.
Now we can define the Debutanizer. Just like with the Atmospheric Distillation Column HYSYS will start the process with a multi-step wizard to walk you through the basic configuration. From the Columns tab in the model Palette chose the Distillation Column sub-flowsheet (the one with both a condenser & a reboiler).

The next step is to pick a type of reboiler. The first entitled Once-through depicts a kettle reboiler & is the one we want (liquid from the bottom tray is the feed to the reboiler, produced vapors are returned to the bottom tray and the liquid exits as the bottoms product). The other two configurations are for thermosiphon reboilers; though used commercially they will not be chosen for this example. Click Next> when done.
The next form is for entering the basic pressure profile. Enter the values from Table 5. Click Next> when done.

For this tower we will skip entering temperature estimates. Click Next>.

On the next form enter the reflux ratio & distillate rate. Click Done... when finished.

The final step before trying to run is to specify the stage efficiencies to model the stages as real trays. Under the Parameters tab select Efficiencies. Make sure that Overall & User Specified items are highlighted. Apply the same efficiency to all stages representing trays, leaving the efficiencies for the Condenser & Reboiler at 1.0.
Now we can click on the *Run* button. The convergence should be very rapid.

**Vacuum Distillation Column**

The final step is to define the feed heater & Vacuum Distillation Column. Additional steam is injected into the Vacuum Feed Heater to increase velocity & minimize coke formation within the heater. Even though the Vacuum Column is packed it will be modeled as “trays,” i.e., sections of non-equilibrium stages.

The first step is to mix the *Atm Resid* from the Atmospheric Distillation Column with steam upstream of the Vacuum Heater. Place a *Mixer* on the flowsheet & define the following configuration. You will have to define the steam stream; this can be done via the *Worksheet* tab.
### Table 6. Definitions for Vacuum Distillation Column

<table>
<thead>
<tr>
<th>Type</th>
<th>Operating Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Trays” &amp; Efficiencies</td>
<td>14 trays. Numbering from top:</td>
</tr>
<tr>
<td></td>
<td>Tray 1: 100%</td>
</tr>
<tr>
<td></td>
<td>Trays 2 to 11: 50%</td>
</tr>
<tr>
<td></td>
<td>Tray 12: 100%</td>
</tr>
<tr>
<td></td>
<td>Trays 13 to 14: 30%</td>
</tr>
<tr>
<td>Condenser Type</td>
<td>No condenser, LVGO pumparound liquid return to top stage</td>
</tr>
<tr>
<td>Reboiler Type</td>
<td>None, Direct Fired Heater</td>
</tr>
<tr>
<td>Pressures</td>
<td>Top Tray: 50 mmHg</td>
</tr>
<tr>
<td></td>
<td>Bottom Tray: 62 mmHg</td>
</tr>
<tr>
<td>Temperatures</td>
<td>Top 180°F (controlled by top LVGO pumparound)</td>
</tr>
<tr>
<td>Feed Locations</td>
<td>Crude oil to Tray #12</td>
</tr>
<tr>
<td></td>
<td>Stripping Steam at bottom (Tray #14) – 20,000 lb/hr @ 500°F, 150 psig</td>
</tr>
<tr>
<td>Feed Heater</td>
<td>20,000 lb/hr steam injected into heater coils with the Atmospheric Resid feedstock</td>
</tr>
<tr>
<td></td>
<td>(500°F &amp; 150 psig)</td>
</tr>
<tr>
<td></td>
<td>Outlet @ 180 mmHg &amp; 760°F (max); would like 3,000 bpd excess wash liquid (liquid rate</td>
</tr>
<tr>
<td></td>
<td>from tray above feed, #11)</td>
</tr>
<tr>
<td>Pumparounds</td>
<td>LVGO Pumparound</td>
</tr>
<tr>
<td></td>
<td>Draw from Tray #4, returned to Tray #1</td>
</tr>
<tr>
<td></td>
<td>22,300 bpd flow, outlet temperature adjusted to control top temperature of tower;</td>
</tr>
<tr>
<td></td>
<td>approximately 85°F, 42 MMBtu/hr cooling</td>
</tr>
<tr>
<td></td>
<td>HVGO Pumparound</td>
</tr>
<tr>
<td></td>
<td>Draw from Tray #8, returned to Tray #5</td>
</tr>
<tr>
<td></td>
<td>50,000 bpd flow, 150°F cooling</td>
</tr>
<tr>
<td>Products</td>
<td>LVGO from Tray #4; 915°F D1160 T95; 5,000 bpd (approximate)</td>
</tr>
<tr>
<td></td>
<td>HVGO from Tray #8, 1050°F D1160 T95; 21,000 bpd (approximate)</td>
</tr>
<tr>
<td></td>
<td>Slop Wax from Tray #11, 1,000 bp</td>
</tr>
<tr>
<td></td>
<td>Vacuum resid from bottom</td>
</tr>
</tbody>
</table>
The fired Vacuum Heater is separate from the column environment & will be created next. Create a new Heater on the flowsheet & call it Vac Heater. Change the icon to look like a heater instead of a shell & tube heat exchanger. Enter the following connections & set the following outlet conditions to match the vacuum column conditions in Table 6. Note that even though the pressure is specified as 180 mmHg(0C) the value is immediately converted to the units used in the flowsheet, here psig.

![Image of Vacuum Heater connections](image)

Configuring the Vacuum Column for the first time is a multi-step process. First, create an Absorber Column on the flowsheet then double-click to fill in the information. Fill in the basic information for the configuration on the first form. Couple things that are different from the previous two columns:

- Specify that the top stage reflux comes from a Pump-around (note that HYSYS will define this first pumparound & give it a default name; this can be changed later).
- Specify the LVGO, HVGO, & Slop Wax streams on this form as Optional Side Draws (since they are not further processed in side strippers). Note in the image below that

3 Be very careful which units you choose for the pressure. If you choose mmHg(0C)g by mistake you've specified a gauge pressure & will be much too high since it would be above 1 atm instead of at vacuum conditions.
only 2 Optional Side Draws are shown; you will have to scroll down to see the connection for the Slop Wax.
On the next form we’ll initialize the pressure profile. Again, even though the pressures are input in units of \textit{mmHg(0C)} they get converted to \textit{psig}. Click \textit{Next}>.

The next form will allow us to add temperature estimates & flow information for the top pumparound. Enter the data for the LVGO Pumparound. We will skip adding temperature estimates on this form & show how they can be added later. Click \textit{Side Ops>}.  

There are no side strippers or rectifiers so skip the next 3 forms for \textit{Reboiled Side Stripper Connections, Steam Stripped Side Stripper Connections,} \textit{& Side Rectifier Connections.}

There is already one pumparound defined (since we specified a pumparound return to provide the top stage reflux). Let’s changed the Name from the default to \textit{LVGO Pumparound}. Then click \textit{Add Pump-Around} and define the \textit{HVGO Pumparound}. Click Install to add to the list. Click \textit{Next>} when done.
We will skip the next form for *Vapor Bypass Connections*.

The next form allows us to add the HVGO Pumparound specs. Note that the specs for the LVGO Pumparound were previously entered & are shown here. Click *Next* when done.

On the last form we will accept zero pressure drops through the pumparounds. Click *Done*...

Before we try running the column we need to enter the efficiencies for the stages. Select *Efficiencies* under the *Parameters* tab & enter the values from Table 6.
We skipped adding temperature estimates before but we can add them now. Go to the Profiles item under the Parameters tab. It's pretty typical to have a top temperature of about 150°F (this will actually be changed to be one of our specifications) & a bottom temperature of 700°F. You may also want to specify the 2nd stage temperature of 325°F (since there is a significant cooling between the top & next stage).

Before we can run the column we have to specify something about the side draws (LVGO, HVGO, & Slop Wax). Let's specify the estimated flow rates and use these as specifications. Click on the Specs Summary item under the Design tab; note there are items in this list for LVGO Rate, HVGO Rate, & Slop Wax Rate. You could try to specify the values here, but unfortunately the default units are molar rates, not volumetric. So, we'll have to go back to the Specs option & individually select the item for rate, press the View... button, & make the appropriate changes. When done you can go back to the Specs Summary item to see that all values have been added.
Now let's change the performance of the LVGO Pumparound to adjust the return temperature in that pumparound to meet the temperature spec at the top of the column. Select the Specs item under the Design tab & click Add… Select Column Temperature in the list of Column Specification Types & click Add Spec(s)... add a spec for the top temperature. To make it active go to the Spec Summary item, uncheck the LVGO Pumparound_TRet(Pa) & check the Top Temperature spec.
The final step is to define the steam to the bottom of the column. Under the *Worksheet* tab go to the *Compositions* item. Enter a 1 for the H2O value for *Vac Column Steam*. This brings up the screen to add detail to the composition; click *Normalize & OK*. Select the *Conditions* item & specify the *Temperature*, *Pressure*, & *Mass Flow*. 

![Diagram of software interface showing steam flow to the bottom of a column](image-url)
You may not even need to press Run. Once you enter the remaining steam information the Vacuum Column should automatically run & converge fairly quickly.

The Vacuum Column has converged but to the flowrates that should be estimates, not the composition specs (as defined by the T95 values). We can add the D1160 specs for the LVGO & HVGO in a similar manner to the Atmospheric Column specs except that these streams are direct liquid draws from the main column & do not go through side strippers. To set the LVGO spec first Add a Column Cut Point from the Specs item on the Design tab. However, for right now we do not want to make them active; click on the Summary tab & uncheck the Active box. You can also go to the Specs Summary item & make sure that these new D1160 specs are not checked in the Active column.
It is also useful to add specs for the liquids flowing from the LVGO to the HVGO section (from tray #4) and the overflash back to feed tray (from tray #11). These can be added as a Column Liquid Flow spec. Make sure you specify the values as Std Ideal Vol for the Flow Basis & ensure that the Active box is unchecked on the Summary tab's form.
Before we apply the D1160 specs for the HVGO & LVGO let's examine some of the internal flowrates. The most important is the liquid runback to the feed tray; this will be the liquid rate from Tray #11. Select the Specs item under the Design tab & then select the Net from #11 item in the Column Specifications. In the Specifications Details area we can see that we'd like to apply a Specification Value of 3,000 bpd & currently have 12,800 bpd. We have some flexibility to pull additional HVGO and/or LVGO without drying up the column.

Let's look at the HVGO D1160 T95 value. We want 1050°F & we actually have 985.1°F. This is reasonably close; we'll increase the HVGO draw rate to increase this value to the spec. Go to the Spec Summary, uncheck the Active box for HVGO Rate, & check the Active box for HVGO D1160 T95. The simulation should quickly converge. Go back to the Specs form to check the actual HVGO D1160 T95 value; it should be 1050°F. (If not, press, Reset & Run.) Note that the HVGO rate is larger as expected, 25,580 bpd vs. 21,000 bpd. Also note that the Net from #11 flowrate has decreased to 3,016 bpd.

Now let's look at the LVGO results. For 5,000 bpd LVGO rate the D1160 T95 value is too low, 853.2°F instead of the desired 915°F. Since the T95 value is too low, we can increase the LVGO draw rate to try to meet this spec. Let's apply this D1160 spec instead of the flowrate spec. The column will converge. The LVGO flow rate has increased to 7,661 bpd, the HVGO flow rate has actually decreased to 18,380 bpd, and the Tray #11 liquid runback has increased to 4,193 bpd.

Let's go back to the runback rate. This rate is too large & how could we decrease? We actually have to back up to the Feed Heater & decrease the temperature so that we don't boil up as much gas oils. We can manually adjust to 751.1°F to get 3,008 bpd runback from Tray #11.

Stream & Unit Analyses

Now that the simulation has been run & converged we want to be able to analyze the results. First we'll look at ways of further examining unit & stream results.
First, let’s look at the temperature & liquid/vapor traffic in the Atmospheric Column. Let’s double click on Atm Col & click on the Parameters tab. Select the Profiles option & you can see the temperatures, pressures, & liquid & vapor flows for all of the trays (including the side stripper trays at the bottom of the list). Notice there are several options for showing the liquid & vapor flows: molar, mass, & 3 types of volume. The molar & mass quantities should be self-evident, but the volume factors are somewhat confusing:

- **Act. Volume** – this is the volumetric flow based on the density at the temperature & pressure conditions (as calculated by the corresponding density method, usually COSTALD). This is the most appropriate value to use when determining the hydrodynamics on the tray & within the column.

- **Volume** – this is the standard liquid volume as calculated from each component’s specific gravity value & blended by the mass amount of each component in the mixture assuming ideal mixing (i.e., no shrinkage effects). This is the most normal definition for “standard liquid volume.” Note the values in the vapor column are not related to the volumetric flow as a gas (ideal or otherwise); this is the volumetric flowrate if the vapor was condensed to a liquid.

- **Std Ideal Vol** – this is the volumetric flow calculated, not at the actual pressure & temperature for the fluid, but rather at the standard temperature & bubble point pressure (again by the COSTALD method). This will be very similar to the Volume value but will include shrinkage effects. This is a value calculated by HYSYS but very few other simulation programs. Note the values in the vapor column are not related to the volumetric flow as a gas (ideal or otherwise); this is the volumetric flowrate if the vapor was condensed to a liquid.

Which of these values should you use? This depends on your purpose:
• If you’re trying to track how much of each fraction goes out with each side stream, then use the Volume values. As long as there is no chemical reaction these values are conserved (since they are essentially a transformed mass amount).
• If you are doing hydraulic calculations then use the Act Volume values.
• If you want to determine the ideal gas flows (such as scf of a produced light gas) then start with Molar flow values & convert the units as appropriate.

What are some of the properties of interest for streams? In general we will want to know:
• How much?
• What quality?
• At what conditions?

Let’s first look at the Kerosene stream. We can double-click on the Kero stream in the Flowsheet & look at the Conditions item under the Worksheet tab. This shows us answers to “how much” & “at what conditions.” We can see the pressure & temperature, flowrate in various sets of units (mass, molar, standard liquid volume, & actual volumetric flow at operating conditions).
If we want to see other physical properties for this stream we would select the Properties item. Now we can see an extensive set of physical & transport properties for this stream. This answers a great deal of the “what quality” questions.

The Composition item will show tables of the stream’s composition using multiple possible bases: molar, mass, & standard liquid volume. The default will generally be for mole fractions. But pressing the Basis… button will allow you to change to other types on both fractional & flowing values. When working with petroleum fluids the liquid volume fractions or flows are very convenient.
Since we are working with petroleum streams we may also want to determine the distillation curve associated with a stream composition. For this we’ll use one of the Stream Analysis options. You can create a stream analysis for the first time by right-clicking on a stream & choosing Create Stream Analysis & then Boiling Point Curves. A more general way to create a new analysis or review an existing analysis is to choose the Steam Analysis drop down list & choosing the Boiling Point Curves option in the Home tab of the ribbon. Choose the Kerosene stream & click OK.

Please note that there is a second similar option, Petroleum Assay, but do not choose this. The two options give slightly different results. The Boiling Point Curves option is consistent with the correlations used for the tower specs. The Boiling Point Curves option is also consistent with what can be calculated using the amounts & boiling points for the pseudo components.
Note that we have various distribution curves based on the cumulative yield for the stream. Two of the curves that will be of most interest are the TBP & ASTM D86 curves. Note that not only can we get the results in tabular form but we can also directly make a plot.
You can also create a Stream Analysis by right-clicking a stream & picking the appropriate option. For example, right-clicking on the Diesel stream can get you to the option shown & will create a set of boiling point curves.

**Export results to spreadsheet**

There are many times that you’d like to create a general table of stream and/or unit results to a spreadsheet so that you pick & choose various values for *ad hoc* reports. There are a couple options for doing this.
HYSYS has a default workbook that summarizes a great deal of the stream & unit information in a single location. Click on the Workbook button under the Home tab of the ribbon & choose the default workbook for Case (Main).

You should see a series of tabs that summarize the input & calculated results for the main flowsheet: conditions for the material streams, mole fractions for the pure & pseudo components for the material streams, values for the energy streams, & a summary listing for the unit operations.

Let’s look at the table of Material Streams. Note that the default format is to have information for each stream in a column & items of information in each row. One might expect that the columns would continue out of view off to the right. Instead, however, only a small set of columns are shown & then the information for the next set of columns is shown below. This is unfortunate in that if you were to copy & paste into a spreadsheet this same format is retained. This can be demonstrated:

- Open up Excel
- Go back to HYSYS & select any cell
- Right-click & choose Select All
- Right-click & choose Copy
- Go back to Excel & highlight any cell (preferably A1)
Paste (either by pressing Ctrl-c or right-click & select the paste text icon). After resizing the columns in Excel you should see table like below.

You have the data but it is in a format that is relatively difficult to use.

There is an option to directly export the workbook information directly to Excel. Press the Excel button on the Workbook tab in the ribbon. Choose which of the pages you’d like to export (here we’ll choose them all) & how many columns to produce before repeating below (50 should be sufficient for this example). Press Export to Excel. A set of macros will run that will open a new Excel spreadsheet & values will be copied from the HYSYS simulation to the spreadsheet. Be patient, this may take a while. (It might be a good time to get up & get that cup of coffee you’ve been wanting.)
After adjusting column widths the product spreadsheet will look like the following. Note that there will be at least 50 columns before the information is repeated below row 9. Also, the color formatting showing the user input values (in blue) is retained.
There are a couple limitation to this default workbook report. One is the information reported in the Composition tab – it is only for the mole fractions. For petroleum streams liquid volume fraction would be more convenient. To get this then you’ll have to create a custom workbook sheet and/or report.

Let’s look at some report options that come with HYSYS. Click on the Reports button in the Home tab of the ribbon. At the bottom of the form we’ll want to choose one of the existing templates for the Excel Reports. Click on the Browse Template button. On the next window choose petroleum-refining.wrk (make sure you’re in the appropriate folder to choose this). Now when you click on the Create button a set of macros will run that will open a new Excel spreadsheet & values will be copied from the HYSYS simulation to the spreadsheet. This will also take a while. (It might be a good time to refill that cup of coffee.)
The Excel spreadsheet produced this time has additional information useful for analyzing petroleum streams. If you look at the Compositions tab you’ll see that this still reports mole fractions (so no difference here). But if you look at the Material Streams tab you can see that a lot of the data from the Conditions & Properties items are in the Material Streams tab. This will also contain the TBP & D86 assay information from the Steam Analysis. (Unfortunately these are boiling point curves consistent with the Petroleum Assay option; we will not want to use these.)

Let’s go back to HYSYS & look at the workbook for Case (Main). Notice that the Materials Streams tab has now been modified with the extra petroleum-related information that we see in the Excel spreadsheet. This implies that customizing the workbook & subsequently exporting to Excel is possible.

Let’s create a new tab in the workbook for the liquid volume flows for each component. Select Setup under the Workbook tab in the ribbon. Let’s Add a new Workbook Tab. Select the Material Stream type. Now there is a new tab called Material Streams 1 with the basic stream conditions.
Let’s change the Name to Liquid Volume Flows. Highlight all of the variables in the Variable list & press Delete. Now we can create a brand-new list of variables.
Press the *Add...* button. From the Variable list expand *Master Comp Volume Flow*; you could highlight all of the components & press the right arrow button. We would get a table with all of the liquid volume flow values for each pure & pseudo component in a weird order (propane at the very bottom, the lighter component not in boiling point order). Instead we can selectively add the light components in the order we which & then, as a group, add the pseudo-components. We can press *OK* when done.

Unfortunately, we have to resize the column for the *Variable* name to see the actual order the variables are in. If you do not like the order then you can press the *Order...* button to change this. Finally, we can close the *Setup* form & see that there is now tab for these component volume flows.
We still have an issue that only 5 stream results are shown in the table & then underneath the next set of steam results are shown, & so forth. This is inconvenient when trying to copy the table of results into Excel & use a single table with values that can be easily indexed. A better format would be to unclick the Horizontal Matrix option at the bottom of the form. Now all properties are in the column headings & all streams are in the rows. Now the table can be easily indexed once copied to Excel.
Let’s address the issue with the distillation curves that we would really like. Let’s create a workbook table that reports the Boiling Point Curves for the stream analyses set up in the simulation. Go to the Workbook tab & press Setup. Similar to what was done before, choose Add. But this time expand the Utility Objects item & select Boiling Point Curves & press OK. The default name should be Boiling Point Curves (rename if necessary); there should be no the default items in the list.
Press the *Add...* button. From the *Variable* list expand *ASTM D86*, selectively highlight the values you want & press the right arrow button. Now we'll get a table with all of the ASTM D86 values as calculated by the routines for the *Boiling Point Curves*. (If you don’t like the order you can also redo when you get back to the Setup form.)
Repeat the steps & choose True BP. This will put the TBP values at the bottom the table.

Now the boiling point curves from the Stream Analyses will be part of the workbook. (Note that this will only show the Stream Analyses you have set up; if you did not set up a Stream Analysis for a stream it will not be here either.) This spreadsheet can also exported to Excel. (Remember, getting coffee is a good way to kill the time while the values are being exported. But don’t blame me if you get a caffeine dependency.)
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ASTM D86 (Cut Pt 0.0%)</td>
<td>T</td>
<td>328.8709911</td>
<td>417.0884845</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>ASTM D86 (Cut Pt 1.00%)</td>
<td>T</td>
<td>365.667306</td>
<td>451.0267719</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>ASTM D86 (Cut Pt 2.00%)</td>
<td>T</td>
<td>386.8596669</td>
<td>474.9207519</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>ASTM D86 (Cut Pt 3.50%)</td>
<td>T</td>
<td>403.7935439</td>
<td>493.3986871</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>ASTM D86 (Cut Pt 5.00%)</td>
<td>T</td>
<td>411.7478792</td>
<td>504.4627412</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>ASTM D86 (Cut Pt 7.50%)</td>
<td>T</td>
<td>422.729483</td>
<td>515.7625720</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>ASTM D86 (Cut Pt 10.00%)</td>
<td>T</td>
<td>429.2831273</td>
<td>523.1400551</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>ASTM D86 (Cut Pt 12.50%)</td>
<td>T</td>
<td>434.5321033</td>
<td>529.141802</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>ASTM D86 (Cut Pt 15.00%)</td>
<td>T</td>
<td>438.3725568</td>
<td>533.7627388</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>ASTM D86 (Cut Pt 17.50%)</td>
<td>T</td>
<td>441.9402361</td>
<td>537.2302747</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>ASTM D86 (Cut Pt 20.00%)</td>
<td>T</td>
<td>445.1387589</td>
<td>540.9155194</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>ASTM D86 (Cut Pt 25.00%)</td>
<td>T</td>
<td>450.2324585</td>
<td>546.8494043</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>ASTM D86 (Cut Pt 30.00%)</td>
<td>T</td>
<td>454.6104603</td>
<td>551.7358884</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>ASTM D86 (Cut Pt 35.00%)</td>
<td>T</td>
<td>458.8465219</td>
<td>556.6770918</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>ASTM D86 (Cut Pt 40.00%)</td>
<td>T</td>
<td>462.760278</td>
<td>561.5698338</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>ASTM D86 (Cut Pt 45.00%)</td>
<td>T</td>
<td>466.4361668</td>
<td>566.0046304</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>ASTM D86 (Cut Pt 50.00%)</td>
<td>T</td>
<td>470.3445562</td>
<td>570.8358688</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>ASTM D86 (Cut Pt 55.00%)</td>
<td>T</td>
<td>474.1256056</td>
<td>575.9582844</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>ASTM D86 (Cut Pt 60.00%)</td>
<td>T</td>
<td>478.1808609</td>
<td>581.5566517</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>ASTM D86 (Cut Pt 65.00%)</td>
<td>T</td>
<td>482.6173902</td>
<td>587.1346174</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>ASTM D86 (Cut Pt 70.00%)</td>
<td>T</td>
<td>486.615146</td>
<td>593.4901277</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>ASTM D86 (Cut Pt 75.00%)</td>
<td>T</td>
<td>491.354834</td>
<td>600.6475564</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>ASTM D86 (Cut Pt 80.00%)</td>
<td>T</td>
<td>495.0469591</td>
<td>608.4033919</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>ASTM D86 (Cut Pt 85.00%)</td>
<td>T</td>
<td>504.5713309</td>
<td>617.249327</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>ASTM D86 (Cut Pt 90.00%)</td>
<td>T</td>
<td>513.8652118</td>
<td>630.3877522</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>ASTM D86 (Cut Pt 95.00%)</td>
<td>T</td>
<td>515.6684171</td>
<td>635.3186934</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>ASTM D86 (Cut Pt 98.00%)</td>
<td>T</td>
<td>521.0910601</td>
<td>645.0095356</td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>ASTM D86 (Cut Pt 99.00%)</td>
<td>T</td>
<td>532.4278724</td>
<td>653.3903443</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>ASTM D86 (Cut Pt 99.80%)</td>
<td>T</td>
<td>539.0449082</td>
<td>661.6736586</td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>ASTM D86 (Cut Pt 99.90%)</td>
<td>T</td>
<td>544.6360348</td>
<td>666.8296885</td>
<td></td>
</tr>
</tbody>
</table>